
HP OpenView Service Desk 3.0

Documentation Addendum

Second Edition
Manufacturing Part Number: N/A

March 2001



Legal Notices
Hewlett-Packard makes no warranty of any kind with regard to this
manual, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. Hewlett-Packard
shall not be held liable for errors contained herein or direct, indirect,
special, incidental or consequential damages in connection with the
furnishing, performance, or use of this material.

Restricted Rights Legend. Use, duplication or disclosure by the U.S.
Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause
in DFARS 252.227-7013.

Hewlett-Packard Company
3000 Hanover Street
Palo Alto, CA 94304 U.S.A.

Rights for non-DOD U.S. Government Departments and Agencies are as
set forth in FAR 52.227-19 (c)(1,2).

Copyright Notice. © Copyright 2000, 2001 Hewlett-Packard Company

Trademark Notices

Java is a U.S. trademark of Sun Microsystems, Inc.

Microsoft is a U.S. registered trademark of Microsoft Corporation.

MS-DOS is a U.S. registered trademark of Microsoft Corporation.

Netscape, Netscape Commerce Server, Netscape Communications,
Netscape Communications Server, the "N" logo, Netscape Navigator, the
Netscape Navigator Included logo, and Nescape Proxy Server are U.S.
trademarks of Netscape Communications Corporation.

Oracle is a registered U.S. trademark of Oracle Corporation, Redwood
City, California.

Oracle Reports, Oracle7, and Oracle7 Server are trademarks of
Oracle Corporation, Redwood City, California.

OSF, OSF/1, OSF/Motif, Motif, and Open Software Foundation are
trademarks of the Open Software Foundation in the U.S. and other
countries.

SQL*Net is a registered U.S. trademark of Oracle Corporation,
2



Redwood City, California.

SQL*Plus is a registered U.S. trademark of Oracle Corporation,
Redwood City, California.

UNIX is a registered trademark of the Open Group.

Windows NT is a U.S. registered trademark of Microsoft Corporation.

Windows and MS Windows are U.S. registered trademarks of
Microsoft Corporation.
3



4



Contents
Preface

1. Reporting

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
Overview of Reporting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20

Generating Database Views . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22

Generating a Data Dictionary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24

Viewing Database Reporting Tables. . . . . . . . . . . . . . . . . . . . . . . . . . . . .27

Using Database Views: Examples with Third-Party Reporting Tools . .28
Creating Reports with Crystal Reports Designer. . . . . . . . . . . . . . . . .28

Adding Database Views to Existing Reports . . . . . . . . . . . . . . . . . . .31
Creating Reports with Business Objects Designer. . . . . . . . . . . . . . . .31

2. Reconciliation

Reconciling your Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .36

Delta Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .38
Reconciling Data from a Command Line . . . . . . . . . . . . . . . . . . . . . . .40
Removing Redundant Items and Relations . . . . . . . . . . . . . . . . . . . . .40

Finding the Items in Service Desk . . . . . . . . . . . . . . . . . . . . . . . . . . .42
Memory Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .43

3. Opening Forms from the Command Line

Examples of Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .46

Defining a command line argument . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47
Command Line Syntax. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47
General Rules for Arguments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .47
Command Line Executable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48
Form Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .48
Display Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .49
5



Contents
Search Criteria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Field Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Extended field names . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Value . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

4. Multiple Sessions

Using multiple sessions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Defining Multi-Session Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

Service Desk Accounts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

5. Extraction Configuration Wizard

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Defining the ODBC Connection. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Defining the System Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Select Source Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Select Source Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Enter the Parent Relation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Join Tables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Filter Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79
Data Sort Order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Enter Settings for Loading Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . 83
Name and Block a Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Error Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
Possible Errors While Reading the ini File . . . . . . . . . . . . . . . . . . . . . 86
Possible Errors While Writing the ini File . . . . . . . . . . . . . . . . . . . . . 87

6. Approval
6



Contents
Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
Overview of Approval . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .91
Approval Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
Approval Roles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .94

Approval Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .96
Inactive . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .96
Active . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .96
Ready. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .96

Approval Result . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
Approved . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
Rejected. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97
Incomplete. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .97

Enabling the Approval Sheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98
Adding Approval Sheets to Forms . . . . . . . . . . . . . . . . . . . . . . . . . . . . .98

Creating Approval Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100
Adding Approvers Outside of an Approval Group . . . . . . . . . . . . . . .102
Modifying Approvers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104
Removing Approvers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .104

Activating Approval Sheets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .105

Monitoring Approval Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .107

Voting on Approval Sheets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .110
7



Contents
8



Figures
Figure 1-1. Reporting Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .21
Figure 1-2. General Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .23
Figure 1-3. Selecting a Time Zone for Database Views . . . . . . . . . . . . . . . . . . . . . . . .23
Figure 1-4. Print Preview of a Data Dictionary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
Figure 1-5. Publishing a Data Dictionary in HTML Format . . . . . . . . . . . . . . . . . . . .26
Figure 1-6. Crystal Reports Gallery . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
Figure 1-7. Crystal Reports Log On Server Dialog Box . . . . . . . . . . . . . . . . . . . . . . . .30
Figure 1-8. Business Objects Universe Parameters Dialog Box . . . . . . . . . . . . . . . . .32
Figure 1-9. Business Objects Add a Connection Dialog Box . . . . . . . . . . . . . . . . . . . .33
Figure 1-10. Business Objects ODBC Drivers Dialog Box. . . . . . . . . . . . . . . . . . . . . .33
Figure 2-1. Setting the Reconciliation Option in Data Exchange . . . . . . . . . . . . . . . .39
Figure 3-1. CLI Search Results dialog box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .50
Figure 4-1. Shortcut Wizard Command Line dialog box . . . . . . . . . . . . . . . . . . . . . . .57
Figure 4-2. Shortcut Wizard Shortcut Name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .58
Figure 4-3. Connection wizard Server Name dialog box . . . . . . . . . . . . . . . . . . . . . . .59
Figure 4-4. Connection Wizard Account Name dialog box. . . . . . . . . . . . . . . . . . . . . .60
Figure 4-5. Connection Wizard Friendly Name dialog box . . . . . . . . . . . . . . . . . . . . .60
Figure 5-1. Extraction Configuration Wizard. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .64
Figure 5-2. ODBC Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .66
Figure 5-3. System Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .68
Figure 5-4. Classes Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .70
Figure 5-5. Currently Selected Source Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71
Figure 5-6. Selecting Source Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .72
Figure 5-7. Currently Selected Table Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .73
Figure 5-8. Select Table Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .74
Figure 5-9. Enter Parent Relation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .76
Figure 5-10. Joined Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .77
Figure 5-11. Add a Joining Condition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .78
Figure 5-12. Filter Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .80
Figure 5-13. Add a Filter Condition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .81
Figure 5-14. Current Sort Order . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .82
Figure 5-15. Sorting Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .83
Figure 5-16. Enter Settings for Loading Classes . . . . . . . . . . . . . . . . . . . . . . . . . . . . .84
Figure 5-17. Name and Block a Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .85
Figure 6-1. Approval Process . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .92
Figure 6-2. Approval Sheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .93
HP Confidential 9



Figures
Figure 6-3. Adding an Approval Sheet to a Form. . . . . . . . . . . . . . . . . . . . . . . . . . . . .99
Figure 6-4. Entering an Approval Group . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .101
Figure 6-5. Adding an Approver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .103
Figure 6-6. Approval Status Change. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .106
Figure 6-7. Approval Vote Preview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .108
Figure 6-8. Approval Vote View. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .109
Figure 6-9. Voting Yes on an Approval Sheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .110
Figure 6-10. Voting No on an Approval Sheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .110
HP Confidential10



Preface
This document is additional information for new features introduced
with HP OpenView Service Desk 3.0 Service Pack 4. The new features
include reporting, reconciliation and improvements in the command line
interface tool.

The information in this document is suitable for a wide audience. The
majority of information is suitable for most users. The reconciliation and
Command Line interface features will be more suitable for system
administrators.

This guide is organized as follows:

• Chapter 1, “Reporting,” on page 19 describes how you can create
reports based on your Service Desk database entries.

• Chapter 2, “Reconciliation,” on page 35 provides details on how to
perform reconciliation when you are using Data Exchange to
minimize the amount of data imported into Service Desk by filtering
out redundant items and relations.

• Chapter 3, “Opening Forms from the Command Line,” on page 45
provides information on configuring and using the command line
executable. The executable can be started by other products to
initialize specific parts of Service Desk.

• Chapter 4, “Multiple Sessions,” on page 55 explains how you can run
more than one Service Desk client (with the same version number) on
the same machine.

• Chapter 5, “Extraction Configuration Wizard,” on page 63 explains
how to use the wizard. The extraction configuration wizard is part of
Data Exchange and can be used to create and maintain export
configuration files.

• Chapter 6, “Approval,” on page 89 explains how the approval feature
in Service Desk can be used to effectively manage and authorize IT
management processes.
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Revision History
When an edition of a manual is issued with a software release, it has
been reviewed and tested and is therefore considered correct at the date
of publication. However, errors in the software or documentation that
were unknown at the time of release, or important new developments,
may necessitate the release of a service pack that includes revised
documentation. Revised documentation may also be published on the
Internet, see the section ”We Welcome Your Comments!’ below, for the
URL.

A revised edition will display change bars in the left-hand margin to
indicate revised text. These change bars will only mark the text that has
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised
edition nullifies all previous editions.

Table 1 Revision History

Edition and Revision Number Issue Date Product Release

First Edition,Approval and
Extraction Configuration Wizard:
User’s Guide

November 2000 Service Desk 3.0
Service Pack 3

Second Edition March 2001 Service Desk 3.0,
Service Pack 4
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Related Publications
This section helps you find information that is related to the information
in this guide. It gives an overview of the Service Desk documentation and
lists other publications you may need to refer to when using this guide.

The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in
using Service Desk and improve your understanding of the underlying
concepts. This section illustrates what information is available and
where you can find it.

NOTE This section lists the publications provided with Service Desk 3.0.
Updates of publications and additional publications may be provided in
later service packs. For an overview of the documentation provided in
service packs, please refer to the readme file of the latest service pack.
The service packs and the latest versions of publications are available on
the Internet. See the section “We Welcome Your Comments!” in this
preface for the URLs.

• The Readme.htm file on the Service Desk CD-ROM contains
information that will help you get started with Service Desk. It also
contains any last-minute information that became available after the
other documentation went to manufacturing.

• The HP OpenView Service Desk: Release Notes give a description of
the features that Service Desk provides. In addition, they give
information that helps you:

— compare the current software’s features with those available in
previous versions of the software;

— solve known problems.

The Release Notes are available as a PDF file on the HP OpenView
Service Desk 3.0 CD-ROM. The file name is Release_Notes.pdf .

• The HP OpenView Service Desk: Supported Platforms List contains
information that helps you determine platform and software
requirements and compatibility. It lists the combinations of platforms
and software Service Desk 3.0 was tested on.
13



The Supported Platforms List is available as a PDF file on the HP
OpenView Service Desk 3.0 CD-ROM. The file name is
Supported_Platforms_List.pdf .

• The HP OpenView Service Desk: Installation Guide covers all aspects
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP OpenView
Service Desk 3.0 CD-ROM. The file name is
Installation_Guide.pdf .

• The HP OpenView Service Desk: Data Exchange Administrator’s
Guide explains how you can use data from other applications in
Service Desk. It explains the underlying concepts of the data
exchange process and gives step-by-step instructions on exporting
data from external applications and importing it into Service Desk.
The data exchange process includes importing single service events
and batches of data.

The Data Exchange Administrator’s Guide is available as a PDF file
on the HP OpenView Service Desk 3.0 CD-ROM. The file name is
Data_Exchange.pdf .

• The HP OpenView Service Desk: API Programmer’s Guide contains
information that will help you create customized integrations with
Service Desk. This guide depicts the API structure, and explains
some of the basic functions with examples for using the Application
Programming Interface (API) provided with Service Desk. The API
extends the HP OpenView Service Desk environment by providing
independent programmatic access to data-centered functionality in
the Service Desk application server environment.

The API Guide is available as a PDF file on the HP OpenView Service
Desk 3.0 CD-ROM. The file name is API_pg.pdf .

• The HP OpenView Service Desk: Data Dictionary contains helpful
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP
OpenView Service Desk 3.0 CD-ROM. The file name is
Data_Dictionary.htm .

• The HP OpenView VantagePoint Service Desk 3.0 Computer Based
Training (CBT) CD-ROM is intended to assist you in learning about
the functionality of HP OpenView VantagePoint Service Desk 3.0
from both a user and a system administrator perspective. The
CD-ROM contains demonstration videos and accompanying texts that
14



explain and show how to perform a wide variety of tasks within the
application. The CBT also explains the basic concepts of the Service
Desk application.

The CBT is shipped automatically with the regular Service Desk
software on a separate CD-ROM.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you are
a novice or an experienced user;

— background and overview information to help you improve your
understanding of the underlying concepts and structure of Service
Desk;

— information about error messages that may appear when working
with Service Desk, together with information on solving these
errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk
application and can be invoked from within Service Desk. See the
following section entitled “Using the Online Help” for more
information.

Reading PDF Files
You can view and print the PDF files with Adobe Acrobat Reader.
This software is included on the HP OpenView Service Desk 3.0
CD-ROM. For installation instructions, see the readme.htm file on the
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help
You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of
the following:

— Press F1.

— Click the help toolbar button .

— Choose Help from the Help menu.
15
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— Click the help command button in a dialog box.

• To search for help on a specific subject using the table of contents or
the index of the help system: choose Help Contents & Index from
the Help menu.

When you are in the help viewer, you can find help on how to use the help
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen
items like buttons, boxes, and menus.

A tooltip is a short description of a screen item. To view a tooltip, rest the
mouse pointer on the screen item. The tooltip will appear at the position
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item.
“What’s This?” help generally gives more information than tooltips. To
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the following
ways:

• Press Shift+F1 .

• Click the “What’s This?” toolbar button .

• Choose What’s This? from the Help menu.

• In dialog boxes, click the question mark button in the title bar.

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any
key on your keyboard.
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Typographic Conventions
The table below illustrates the typographic conventions used in this
guide.

Font What the Font Represents Example

Italic References to book titles See also theHP OpenView Service
Desk: Installation Guide.

Emphasized text Do not deletethe System user.

Bold First-time use of a term that is
explained in the glossary

Theservice callis the basis for
incident registration.

Courier Menu names You can adjust the data view with the
commands in theView menu.

Menu commands ChooseSave from the menu.

Button names ClickAdd to open the Add Service
Call dialog box.

File names To start the installation, double-click
setup.htm .

Computer-generated output, such as
command lines and program listings

If the system displays the text
C:\>dir a:
The device is not ready
then check if the disk is placed in the
disk drive.

Courier bold User input: text that you must enter in a
box or after a command line

If the service call must be solved
within 30 minutes, enter30 .

Courier italic Replaceable text: text that you must
replace by the text that is appropriate
for your situation

Go to the folderX:\\Setup, whereX is
your CD-ROM drive.

Helvetica bold Keyboard keys

A plus sign (+) means you must press
the first key (Ctrl in the example), hold
it, and then press the second key (F1 in
the example).

PressCtrl +F1.
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We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and
better meet them. We are interested in what you think of this manual
and invite you to alert us to problems or suggest improvements. You can
submit your comments through the Internet, using the HP OpenView
Documentation Comments Web site at the following URL:

http://ovweb.external.hp.com/lpe/comm_serv

If you encounter serious errors that impair your ability to use the
product, please contact the HP Response Center or your support
representative.

The latest versions of OpenView product manuals, including Service
Desk manuals, are available on the HP OpenView Manuals Web site at
the following URL:

http://ovweb.external.hp.com/lpe/doc_serv

Software patches and documentation updates that occur after a product
release, will be available on the HP OpenView Patches Web site at the
following URL:

http://ovweb.external.hp.com/cpe/patches
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1 Reporting

This chapter describes how you can create database views and a data
dictionary for use by your third-party reporting tool. Using the
information provided in this chapter, you can create reports based on
your Service Desk database entries.
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Introduction
Introduction
The delivery of business-critical IT services depends on prompt decision
making. Steps within the IT management process may need to be
reviewed to monitor agreed-upon service levels. When reviewing IT
management processes, it is counter-productive and time-consuming to
manually track issues.

Using Service Desk, you can create reports that provide an effective
method of managing your IT management processes.

Overview of Reporting

Reporting provides flexibility and convenience for reviewing past,
managing current, and forecasting future infrastructure needs. For
example, you want to monitor the performance of a configuration item.
By printing a report of all service calls for a particular CI, you can view
statistics on the average availability of a CI based on any specified time
period.

Your Service Desk database provides the information used as a basis for
your reporting tool. Your reporting tool, such as Business Objects,
Crystal Reports, Microsoft Access, or Microsoft Excel, can access the
information stored in Service Desk when you create database views and
a data dictionary. When using an Oracle based Service Desk database,
your reporting tool can view Service Desk entries using the ODBC or
SQL drivers. When using an SQLServer based Service Desk database,
your reporting tool can view the Service Desk entries using ODBC or
SQL drivers. Service Desk, however, recommends using specified drivers,
ODBC drivers with Oracle and SQL drivers with SQLServer, for
performance optimization. Using queries defined in your Service Desk
database views, you provide a view into your database which can be
imported by your reporting tool to create professional reports, as
depicted in Figure 1-1.
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Figure 1-1 Reporting Process

Service Desk

Service Desk
Database

Third Party Reporting Tool

Database Views
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Generating Database Views
The first step in the Reporting process is the generation of database
views. Using database views, you can create a professional report, for
example, by using the Crystal Report Wizard.

Service Desk gives you control over which parts of your database you can
use. For this reason, you need to take additional steps to create the
specific views into your database. Each view determines what
information you want to form the basis of your report.

Database views are localized based on the language of your third-party
reporting tool.

To generate database views:

1. In Service Desk, choose System from the Tools menu. The
Administrator Console is displayed.

2. In the Administrator Console, select the System Panel icon.

3. Double-click the General Settings icon. The General Settings dialog
box is displayed.
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Figure 1-2 General Settings

4. Click (Re)generate database views for reporting .

5. Select a time zone in the Generate Reporting Database Views Do
You want to Continue dialog box. A time zone must be selected from
the drop-down list.

Figure 1-3 Selecting a Time Zone for Database Views

6. In the Warning dialog box, click Yes to continue generating database
views.

7. Service Desk will generate the database views.

8. Close the General Settings dialog box by clicking OKor Apply .
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Generating a Data Dictionary
Data is stored in a variety of places and forms. You may have placed your
data in one or two separate databases or your specialists may have
defined tables and fields in what they consider a logical manner but
which other members of your company may not understand. As a result,
providing members of your IT infrastructure the ability to import Service
Desk entries into a reporting tool may create problems and compromise
your data’s integrity.

A Data Dictionary which defines all IT infrastructure terms helps ensure
that there is a general understanding of all terms and that your
company’s database integrity remains intact. By creating a Data
Dictionary, your staff will have data easily accessible in a format that
they can understand.

When a Data Dictionary is used to help define information contained in
reports, only data which is used in the report can be accessed via the
Data Dictionary. You cannot simultaneously use the Data Dictionary and
another data source in the same report.

To generate a Data Dictionary:

1. In Service Desk, choose System from the Tools menu. The
Administrator Console is displayed.

2. In the Administrator Console , select the System Panel icon.

3. Double-click the General Settings icon. The General Settings dialog
box is displayed.

4. In the General Settings dialog box, click the Generate Data
Dictionary button. The Print Preview appears on your screen.
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Figure 1-4 Print Preview of a Data Dictionary

5. You can choose to print or publish the Data Dictionary.

• Create a report in HTML format using your reporting tool by
selecting Publish from the toolbar to save the Data Dictionary in
HTML format; or

• Print your report using your reporting tool by selecting Print
from the toolbar to print the Data Dictionary.
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Figure 1-5 Publishing a Data Dictionary in HTML Format

6. Click Close in the Data Dictionary Print Preview.

7. Click Close in the General Settings dialog box.
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Viewing Database Reporting Tables
After you have generated the database views and created the data
dictionary, you will need to access the database. Consult your database
administrator for the user name and password to access the database
tables.

When viewing the database tables, you will note that all views created
for reports have the prefix V_.

NOTE In addition to operational data, repository data such as account
information will be displayed in the database views. Although you
cannot modify data using the database views, you will be able to view all
repository information in the reporting tables.

You can import the database views with the V_ prefix into your reporting
tool.
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Using Database Views: Examples with
Third-Party Reporting Tools
After creating your database views, you can use the views to create
reports from your Service Desk database without requiring database
command knowledge. Your third-party reporting tool accesses database
tables to produce a report that you can edit and format, combining items
such as data, charts, pictures and sound.

Because third-party reporting tools use visual layout approach, you can
specify the data that you want to appear to edit and format reports. You
can decide the report format, using drag and drop techniques to arrange
data, graphics, charts and text.

Creating Reports with Crystal Reports Designer

To create a new report based on Service Desk database views:

1. From the File menu, select New. The Report Gallery appears.
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Figure 1-6 Crystal Reports Gallery

2. Select any report. For our example, we will choose Standard . The
form Report Expert will appear.

3. Click SQL/ODBC. The Log On Server dialog box appears.
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Figure 1-7 Crystal Reports Log On Server Dialog Box

4. You must log on to the database where your Service Desk views were
created. In our example, we are using HP OpenView Service Desk 3.0
and we select ODBC-HP OpenView Service Desk 3.0 . The Choose
SQL Table dialog box appears.

5. In the Choose SQL Table dialog box, select all file types. Database
view files will have the prefix V_. Double-click the database view files
to be used in your report.

6. The database views which will be included in your report will appear
in the Report Expert Fields pane. When finished, click Done.

7. Click the Fields tab in the Report Expert dialog box.

8. In the Database Fields pane, double-click the fields from your views
to be included on your report. The selected database fields will appear
in the Report Fields pane.

9. Click the Sort tab. Select a database view field to sort data. For
additional information, please refer to Seagate Crystal Reports User’s
Guide.

10.Click the Graph tab. Select a format for your report graph by clicking
the Crystal Chart Type or selecting Custom Chart to create your
own. For additional information, please refer to Seagate Crystal
Reports User’s Guide.
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11.Click the Style tab. You can design a report by adding a company
logo, or making other stylistic changes. For additional information,
please refer to Seagate Crystal Reports User’s Guide.

12.When finished, click Design Report . The report you have created
with your Service Desk database views will be displayed.

Adding Database Views to Existing Reports

Database views that you have generated can be added to existing
reports. You can add Service Desk data to a company prospectus, for
example. A report initially designed for financial information could
import Service Desk database views and present IT infrastructure
management statistics.

To add database views to an existing report:

1. Select Add Database to Report from the Database menu. The
Choose SQL Table dialog box will appear.

2. Select the Service Desk database view files to include in your report.
The database view files will have a V_ prefix.

3. The Visual Linking Expert will appear. Click OK.

NOTE The Visual Linking Expert helps you link two or more database tables.
For additional information on using the Visual Linking Expert, please
refer to Seagate Crystal Reports User’s Guide.

Creating Reports with Business Objects Designer

Business Objects utilizes universes to display database data without
requiring users have technical knowledge of databases. Universes are a
tool to provide information on data in understandable terms.

Universes consist of classes and objects. For example, objects in a Service
Desk database view could be configuration items, organizations, service
calls, service call numbers, etc. By grouping objects together, you form
classes. Classes group objects to form a general description. Each object
links to data directly in your database view.

Universes provide the ability to query data to incorporate in your
Chapter 1 31



Reporting
Using Database Views: Examples with Third-Party Reporting Tools
reports. When creating a query in Business Objects, you select objects
from the universe and run a query on those objects.

To create a universe to access your database view:

1. Start Business Objects Report Designer.

2. Select Newfrom the File menu. The Universe Parameters dialog
box appears.

Figure 1-8 Business Objects Universe Parameters Dialog Box

3. Enter a name for your universe in the Namefield.

4. You will need to provide your universe with access to Service Desk
data. To do this, you will need to indicate the database and the type of
network you are working with and set the parameters to access the
database views stored in your Service Desk database. Create a new
connection for your universe by clicking New.

5. The Add a Connection dialog box will appear.
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Figure 1-9 Business Objects Add a Connection Dialog Box

6. Select the network driver for your Service Desk database. For our
example, we will select ODBC Drivers . Click OK.

7. Enter a name for the connection in the Namefield.

8. Select a database engine from the Database engine drop-down list.

Figure 1-10 Business Objects ODBC Drivers Dialog Box

9. Select HP OpenView Service Desk 3.0 from the Data Source
Namedrop-down list.
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10.Enter a user’s name and password for the Service Desk database.

11.Click OK.

12.Select Tables from the Insert menu.

13.In the Table dialog box, click the database views you want to add to
the universe structure. The database views will have the prefix V_.

To add several database views, hold down the Control key while
clicking each database view.

14.Click Insert .

When you have finished designing your report, you can use your basic
design to create professional reports. For additional information, refer to
the Business Objects User’s Manual.
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2 Reconciliation

The Reconciliation feature in Data Exchange minimizes the amount of
data imported into Service Desk by filtering out redundant items. A
reconciliation change list is created that identifies obsolete objects that
may require manual removal from Service Desk.
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Reconciling your Data
The Reconciliation process filters out redundant information so that only
the changes in your data are imported, thus reducing the load on your
resources. This is accomplished by comparing the most recently exported
data exchange XML file with the data exchange XML file currently
exported. The differences between the two files are then recorded into an
additional XML file for importing into Service Desk. To use the
reconciliation feature you must have a valid Data Exchange xml file for
comparison purposes. During the import process the current xml file will
be compared to the older xml file. The following tables explain which
items and relations will be imported:

Table 2-1 Decision Matrix for Importing Items

Item in previous
exchange file?

Item in current
exchange file?

Changes to the
item’s
attributes?

How is item
processed?

No Yes Not Applicable Import item

Yes No Not Applicable Remove item
manually

Yes Yes No No action taken

Yes Yes Yes Import item

Table 2-2 Decision Matrix for Importing Relations

Item in
previous
exchange
file?

Item in
current
exchange
file?

Is the
relation new
or changed?

Has the
relation
been
removed?

How will
relation be
processed.

No Yes Yes Not
Applicable

Import
relation

Yes No Not
Applicable

Yes Remove
relation
manually
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Yes Yes No No No action
taken

Yes Yes Yes No Import
relation

Yes Yes No Yes Remove
relation
manually

Table 2-2 Decision Matrix for Importing Relations

Item in
previous
exchange
file?

Item in
current
exchange
file?

Is the
relation new
or changed?

Has the
relation
been
removed?

How will
relation be
processed.
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Delta Processing
The option to import your reconciled data is called delta processing and
is set in the Data Exchange dialog box. When this option is selected, new
items and relations will automatically be imported. Modified items and
relations will automatically be updated. Redundant (obsolete) items and
relations will need to be removed manually, See “Removing Redundant
Items and Relations” on page 40.

To set the Delta processing option in the Data Exchange dialog box:

1. Open an existing Data Exchange task or create a new Data Exchange
task. Refer to the Data Exchange Administrator’s Guide or the Online
help for more information.

2. Place a check in the Use delta processing check box. It is located in
the lower half of the dialog box:
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Figure 2-1 Setting the Reconciliation Option in Data Exchange

3. In the Previous Exchange field, enter the previous data exchange
xml file you will use to compare with the current data exchange xml
file. A Browse button is available below the field, for locating the file.
A date and time will be automatically added to your data exchange
xml file during the data exchange process. The date format is
yyyy/mm/dd/HH:mm, for example DTA_200101101644.xml refers to
2001, January, 10th, 16:44.
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You can use a command line to call sd_import for importing data using
reconciliation. The command structure is:
sd_import
<username ><password ><server ><mapping ><datafile ><debugging >
<logfile ><temp dir ><reconciliation data
file ><reconciliation change list >

For more information about running Data Exchange from the command
line, refer to the Data Exchange Administrator’s Guide. An example
command line using reconciliation follows:
sd_import system servicedesk LOCALHOST dta5 dta5.xml Y
dta5_imp.log c:\temp dta5_200101101645.xml dta5_changes.log

Removing Redundant Items and Relations

During the reconciliation process a change log is created recording all
new, modified and redundant items and relations. To complete the
reconciliation process in Service Desk you will need to remove redundant
items and relations manually, see Table 2-2, “Decision Matrix for
Importing Relations,” on page 36, and Table 2-1, “Decision Matrix for
Importing Items,” on page 36. By using the change log you can quickly
find the items and relations that have become obsolete. Every item is
recorded with key fields and values, making it possible to locate those
items quickly in Service Desk.

The change log is created in the data_exchange/log directory with the
current date and time. For example, DTA_Changes_200101101644.log .
In the following example the REDUNDANT ENTITIES and
REDUNDANT RELATIONS sections contain information that will help
you locate those items that you will probably want to manually removal
from Service Desk:

Example 2-1 Change Log File

Change Log File

--------------------------------------------------------

ChangeList of delta processing on files

e:\a.xml (new situation) and

e:\b.xml (old situation).
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Date of import: Wed, 10/01/2001 16:44:19

------------------------------------------------------------

NEW ENTITIES

============

CL_CI with ID 282 with key-values:

CI_ID : 1000000677

UPDATED ENTITIES

================

CL_CI with ID 375 with key-values:

CI_ID : 1000000887

CL_CI with ID 676 with key-values:

CI_ID : 1000001347

CL_CI with ID 911 with key-values:

CI_ID : 1000001860

REDUNDANT ENTITIES

================

CL_CI with ID 105 with key-values:

CI_ID : 1000000945

NEW RELATIONS

=============

relation between

CL_CI_COMPONENT_CHILD with ID 1356 with key-values:

CI_ID : 1000001279

and

CL_CI_COMPONENT_PARENT with ID 1350 with key-values:

no key-values

relation between

CL_CI_COMPONENT_CHILD with ID 1436 with key-values:
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CI_ID : 1000001302

and

CL_CI_COMPONENT_PARENT with ID 1432 with key-values:

no key-values

REDUNDANT RELATIONS

=================

relation between

CL_CI_COMPONENT_CHILD with ID 1356 with key-values:

CI_ID : 1000001279

and

CL_CI_COMPONENT_PARENT with ID 1352 with key-values:

CI_ID : 1000001275

relation between

CL_CI_COMPONENT_CHILD with ID 1436 with key-values:

CI_ID : 1000001302

and

CL_CI_COMPONENT_PARENT with ID 1434 with key-values:

CI_ID : 1000001297

Finding the Items in Service Desk

The change list describes the changed items and relations with their
class names and field names as in the xml file. To find the items and
relations, you will need to follow the import mapping created for the
item. In the import mapping, for example, class CL_CI from the xml file
is mapped to the Service Desk item Configuration Item . The property
CI_ID from the xml file is mapped to the ID field in Service Desk.

From the example change list the following entry represents and item in
Service Desk that needs to be located and removed:

REDUNDANT ENTITIES

================

CL_CI with ID 105 with key-values:
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CI_ID : 1000000945

To locate the obsolete item, look for the Configuration Item in Service
Desk and search for ID 105 .

Memory Usage

The values of all key fields are cached during import to make it possible
to locate parent items and relations when processing a relation. The
smallest memory format practical is used.
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3 Opening Forms from the
Command Line

Included with Service Desk is an executable that can be started by other
products to initialize specific parts of Service Desk.
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Examples of Use
The command-line interface can be used in various integrations. In a
command-line integration an external application calls Service Desk
classes and passes arguments in the call. The call can be made through
the DOS prompt.

For example: helpdesks often make use of CTI (Computer Telephony
Integration) applications. CTI applications are used to route telephone
calls automatically to the right help desk employee. The CTI application
can call external programs, passing the telephone number of the caller
over the command line. The command string passed over the command
line can identify and search for all previous or open Service Calls from
that caller. The helpdesk employee can then see an overview of the
service calls logged by the caller in the Command Line Interface before
picking up the telephone.

NOTE The application kicking off the command line action and Service Desk
(client) must be installed on the same computer.
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Defining a command line argument
Use the executable SDDataForm.exe to open a specific form in Service
Desk from the command line of another application. The form can be a
standard form, or one created specially for the purpose, but the form
must exist before it can be called by the executable. You will need to
know the exact name of the form for the command line argument. Forms
are created and edited in the Form Designer feature of the
administrators console. To open the Form Designer select System from
the Tools menu, then open the Forms branch from the Presentation
node.

Command Line Syntax

The syntax for the command line is:

<service desk path\bin> SDDataForm.exe <Form name> <Display
option> <Search criteria>

For example:

SDDataForm.exe “Service call” -ListAlways ID=200

The above example searches for the form Service Call, and any service
call records with the ID number 200. The results are displayed in the
Search Results dialog box even if no matching database records are
found. Each element of the command line argument is described below.

General Rules for Arguments

When composing command line arguments, the following points should
be kept in mind:

• Whenever a form name or field name value contains any character
not recognised by DOS or that DOS gives a different meaning (for
example a space,’ >’ symbol, or a period) the name must be included in
quotation marks.

• All arguments are case-sensitive.

• The search value entered in the command line argument must be
identical in format to the value stored in the database. For example, if
a CTI application identifies a telephone number of an incoming call as
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0123456789, but the number is stored on the database as 012 345
6789 (with spaces), no occurances of the telephone number will be
found, and the search will fail.

• Command Line arguments must contain the path variable unless the
DOS command indicates the correct directory (folder) at the DOS
prompt. The executable file SDDataForm.exe is located in the
Service Desk \bin folder of both the client and server installations.

• The client user must have access rights to the form being called.

Command Line Executable

The executable file used by Service Desk to do a database search, and
open forms from data passed via the command line is SDDataForm.exe .
This executable is located in the Service Desk \bin folder of both the
server and client installations.

SDDataForm.exe must be named first in the command line string unless
DOS needs to be told where to find it, this will not be necessary if the
DOS prompt is already in the \bin directory. If the prompt is not in the
right directory the path for SDDataForm.exe must be inserted first in the
string.

Form Name

The first argument in the command string must be the name of an
existing form. If two or more forms have the same name, the first one
created will be used.

To find the form names, do the following:

Step 1. In Service Desk, choose System from the Tools menu. The
Administrator Console dialog box is displayed.

Step 2. In the Administrator Console , select the System Panel node and
double click the General Settings icon. The General Settings dialog
box is displayed.

Step 3. In the General Settings dialog box, click the Generate Data
Dictionary button. An HTML file is created.

Step 4. In the generated HTML file find the form name you want.
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Display Options

The display options define how the results of the database search are
treated. There are three possible outcomes of any database search, no
matching records are found, one matching record is found, or multiple
matching records are found. How Service Desk responds to these three
possibilities can be defined using one of three display options:

• No option defined. The Service Desk default is that if you do not
define a specific display option, the following actions will occur: when
no records are returned from the search a new form will be opened,
when a single record is returned, this record will be opened
automatically in Modify mode, when multiple records are found the
Search Results dialog box will open displaying a list of all returned
records.

• -ListAlways will cause the Search Results dialog box to be
displayed even when no records, or only one record is returned. The
user will have to click the Newbutton if they then want to create a
new record.

• -ForceNew will cause a new instance of the named form to be
displayed, regardless of any search criteria.

When Service Desk finds more than one item in a search, or when the
display option is set as ListAlways , the Search Result dialog box is
shown. To open an item shown in the Search Result dialog box select it
and click Open.
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Figure 3-1 CLI Search Results dialog box

Search Criteria

Search criteria are optional, however if no criteria are set then all
instances of the named form in the database will be retrieved and
displayed in the Search Results dialog box. Multiple criteria can be
defined.

The search criteria syntax is:

FieldnameOperatorValue

There must be no spaces between the three elements of the search
criteria; Field Name, Operator and Value. Spaces are allowed in the Field
Name or in the Value as long as the whole name or value is enclosed in
quotation marks. For example:

Location=B1R103 “Outsourced to=HP”

will find all configuration items located at location B1R103 that are
outsourced to HP.

Field Name

To find the field names you need, do the following:
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Step 1. In Service Desk, choose System from the Tools menu.

Step 2. In the Administrator Console , open the Presentation node and
then the Forms node.

Step 3. Find the Form you want.

Step 4. Double-click the Form title to open the form.

Step 5. The fields available for inclusion in the form are listed in the
Attributes dialog box, only the fields currently used in the form and
thus displayed in the Form Designer dialog box, should be used for a
command line initiated search.

Extended field names

You can use the fields of related items to find a service call. If you use
field names of related items, the field name is extended with the item
name. Use a period to separate the item name from the field name. For
example, to open service calls using the caller’s telephone number, you
can use the field name: Caller.PrimaryTelephoneNumber . Or, to open a
configuration item using the location’s search code where the
configuration item is placed, use: Location.searchcode .

NOTE To get flavour of what field names and extended field names are possible,
open the Advanced Find dialog box. In the Advanced Find dialog box,
click the Advanced tab and then click Fields . The names in the fields
list can be used as field names. Names in submenus of the fields list
must be used as extended field names.

Operators

You can use the operators shown in the following table:

Operator (Text) Operator
(Symbol)

Usage

Equal = is equal to

NotEqual != is not equal to

GreaterThan > is greater than
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GreaterThanOrEqualTo >= is greater than or equal to

LessThan < is less than

LessThanOrEqualTo <= is less than or equal to

Between is included in the range
defined by two values.
Separate values with AND.
Text strings with spaces or
illegal characters should be
identified by quotation marks.

NotBetween is excluded from the range
defined by two values.
Separate values with AND.
Text strings with spaces or
illegal characters should be
identified by quotation marks.

Contains is one of a list. Separate
values with AND or OR. Text
strings with spaces or illegal
characters should be
identified by quotation marks.

NotContains is not one of a list. Separate
values with AND or OR. Text
strings with spaces or illegal
characters should be
identified by quotation marks.

Empty is empty (no value given,
NULL)

NotEmpty is not empty (value given, not
equal to NULL)

Yesterday date is equal to yesterday’s
date (system date -1)

Operator (Text) Operator
(Symbol)

Usage
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Standard DOS wildcards (* , ?) can also be used in values, for example:
sm* will find Smith, Smythe, Smit, etc.

Whenever the text version of an operator is used it must be contained in
square brackets, with no spaces around it. For example:

ID[Equal]251

Today date is equal to today’s date
(system date)

Tomorrow date is equal to tomorrow’s
date (system date +1)

Last7Days date is one of the last seven
days (Between system date
and system date -7)

Next7Days date is one of the next seven
days (Between system date
and system date +7)

LastWeek date is one of the days of the
last working week

ThisWeek date is one of the days of this
working week

NextWeek date is one of the days of the
next working week

LastMonth date is one of last month

ThisMonth date is one of this month

NextMonth date is one of next month

StartsWith text starts with ......, if the text
string has spaces or illegal
characters the string should
be identified by quotation
marks.

Operator (Text) Operator
(Symbol)

Usage
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NOTE If you want the data found by the search criteria to be inserted
automatically in the named form when a new form is called, insert a +
symbol before each search criteria in the string that you want to be
included in the form. If the criteria is contained by quotation marks,
because of a space or illegal character, place the + symbol inside the
quotes.

Value

The value searched for must be entered in the correct format for
anything to be found, and if that value format contains a space or other
illegal character, such as a period, the value must be contained in
quotation marks.

To find an item on a date, use the date format specified in the system
settings of your computer, for example on April 27, 2001 use: 27/04/2001.
The date format depends on the system settings of your computer.

Search codes must be capitalized. To find an item on a search code, for
example for Steven Barns use: BARNSS.
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4 Multiple Sessions

Service Desk allows more than one Service Desk client (with the same
version number) to be run together on the same machine.
Chapter 4 55



Multiple Sessions
Using multiple sessions
Using multiple sessions
Use multiple sessions when you want to have multiple client
installations of the same version of Service Desk connecting to different
application servers with different databases. This need could arise when
you have different application servers (and databases) for testing,
development, and production (live system), or multiple production
environments.

Do not use multiple sessions for different users on the same machine;
this should be done by setting up proper profiles for each user within the
operating system.

Defining Multi-Session Parameters

To use multi-sessions, the cache, account details, and user definable
information must be separated, and stored locally on the client machine.
This is done by setting up /PROFILE and /USERFOLDER parameters
that are read when Service Desk is started up.

Multi-sessions are created using shortcuts. To set up multi-session
shortcuts on Windows NT4:

1. Right-click on the desktop and select Newfrom the popup menu and
then Shortcut from the submenu. The Create Shortcut wizard is
started.

2. In the Command line field type:
C:\WINNT\wjview.exe com.hp.ifc.ui.AppConsole
/PROFILE=clientAS1 /USERFOLDER=”C:\Program
Files\Hewlett Packard\OpenView\Service Desk
3.0\Client\clientAS1”

You can replace the term “clientAS1” with anything you like; however
it must be the same in both places.
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Figure 4-1 Shortcut Wizard Command Line dialog box

NOTE The path parameters depend on where wjview.exe and the Service Desk
folder are located on the machine. On Windows 2000 wjview.exe
should be found in the System32 folder and on Windows 95/98 in the
Windows folder.

3. Click Next and enter a name for the shortcut, for example: Service
Desk Client AS1. Then click Finish .
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Figure 4-2 Shortcut Wizard Shortcut Name

Once you have created the shortcut, the instance of the client software
that is started by it still has to be connected to an application server and
database. This must be repeated for each client shortcut you create.

1. When you use the shortcut for the first time, the “Get connected”
wizard is started. You will be prompted for the application server
name (for example, Application Server 1). Click Next .
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Figure 4-3 Connection wizard Server Name dialog box

2. Enter the Account Name and Password for the application server that
the client should connect to. Click Next .
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Figure 4-4 Connection Wizard Account Name dialog box

3. Enter a Friendly Name for the application server account name.

Figure 4-5 Connection Wizard Friendly Name dialog box
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4. Click Next and then Finish . The Client shortcut will now connect to
the application server with the specified account name.

When the client is running you will be able to identify each multi-session
client you are using by the title bar and the task bar of the application
window. This will show the /PROFILE parameter value, for example:
clientAS1.

Service Desk Accounts

For each Client shortcut you create you will also need to create an
Application Server Account shortcut. This will enable you to add, modify,
view, or remove the account associated with the Client shortcut.

To create an Application Server Accounts shortcut, follow the
instructions for creating a Client shortcut above, but modify the
command line path to:

C:\WINNT\wjview.exe
com.hp.ifc.ui.options.AppServerAccountsDialog
/PROFILE=clientAS1 /USERFOLDER=”C:\Program Files\Hewlett
Packard\OpenView\Service Desk 3.0\Client\clientAS1”

Logically you should name this shortcut to relate to the client shortcut,
particularly if you are going to have a number shortcuts. As with the
Client, the dialog boxes started from this shortcut will display the value
from the /PROFILE parameter in the title bar (for example, clientAS1).
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5 Extraction Configuration
Wizard

This chapter explains how to create a configuration file for extracting
data from a data source with the Extraction Configuration Wizard.
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Introduction
An export configuration file is needed to extract data from an external
data source. The extraction configuration wizard assists you in creating
and maintaining an export configuration file without having a deep
understanding of SQL, or possessing coding skills. You can select one
from the list, copy and modify one from the list or create a new
configuration file. To start the wizard:

1. Select Programs from the Start menu.

2. In the Programs submenu choose HP OpenView Service Desk 3.0 .

3. Choose the Extraction Configuration Wizard option.

The main dialog box shows all configuration files currently available and
includes three tabbed pages that mirror the structure of the extractor
file:

Figure 5-1 Extraction Configuration Wizard
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These tabs are available when you click New, or select an existing ini file.

• ODBC tab: Use this tab to define the ODBC connection with the
external database. This is the DSN section in the configuration file:

• System tab: Use this tab to define the system and data file settings.

• Classes tab: Use this tab to define the items that will be exported. You
can perform the following tasks using the Extraction Configuration
Wizard started from the Classes tab:

— Select source tables

— Select columns

— Enter the parent relation

— Join tables

— Filter data

— Sort data

— Enter settings for loading classes

— Name and block a class

There are two ways to store the configured file:

• Generate XML now button: Use this button to save the ini file and
generate XML code if you need to check the XML code before
processing. An XML file name must be entered in the configuration
file to perform this step.

• Save ini file button: Use this button to save your settings as an ini
file. This step can be performed at any time during the configuration
of the ini file.

NOTE It is possible to maintain configuration files with a text editor, without
using the wizard. A text editor allows more flexibility for users familiar
with SQL, and the coding of configurable ini files. Additional information
on this subject is available in the HP OpenView Service Desk: Data
Exchange Administrator’s Guide.
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Defining the ODBC Connection
The ODBC tab is used to define the DSN section of the export
configuration file. Fill in the tabbed page as follows:

1. In the Data Source Name field, select the name of the external ODBC
data Source from the drop-down list:

Figure 5-2 ODBC Tab

2. In the User field, enter the name of the database user who owns the
data source tables and views you intend to select, or have selected
from the classes tab.

3. In the Password field, enter the password for the user.
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4. If you are unsure, click Test Connection to verify that the ODBC
connection is valid.

NOTE If you have not already done so, you will need to setup an ODBC link for
this connection to work. You can enter the necessary information to
create an ODBC link by going to the Start menu on your desktop, then
click Settings and then the ODBC icon.
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Defining the System Section
The System tab is used to define the output files you want created during
the export process:

1. Select the Create a log file check box and browse for the location
where you want the log file created:

Figure 5-3 System Tab

2. Select the generate XML check box if you want to create an XML file.
If you want to import the file into Service Desk, you must select this
option. Use the Browse button to select a file location.

3. In the Application name field, enter the name of the external
application you are extracting data from.

4. Select Output to screen to view any extraction errors on your screen
as the extraction process runs.
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5. The extraction process uses ISO-8859-1 encoding as a default. If you
want to use a different code, select the Encoding used check box and
enter the code that will be used instead, for example UTF8.
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The Classes tab is the starting point for defining the classes that you
want to export. In the classes tab you will see the names of any classes
currently in the configuration file, the table and alias source, the parent
for the class, if a filter is applied or if the class is blocked:

Figure 5-4 Classes Tab

• Use the Move up and Move down button to rearrange the classes in
the order that the data should be extracted:

• Click Add to add a class to the configuration file.

• To modify an existing class, select the class and click the Modify
button on the classes tab.

• If you click Add or Modify , a wizard page will open for selecting source
tables.
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Select Source Tables

If you are modifying a configuration file, a list of all currently selected
tables and their aliases is displayed. When you create a new file this
screen will be blank.

To add or remove tables:

1. Click the Source button:

Figure 5-5 Currently Selected Source Tables

2. In the dialog box that appears, select one of the available tables from
the list and click Add to select it. When it is moved to the Selected
tables list you will be able to view the alias for the selected table. You
can add, change, or delete the alias name in the Alias for this
table field, but it must be unique:
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Figure 5-6 Selecting Source Tables

3. Select a table from the Selected tables list and click Removeto remove
it. Once a table is removed the alias name is no longer displayed.

4. Use the Describe button to view the columns of a selected table, the
Describe pop-up will show the type and values of the columns for the
table.

5. Use the Show Value button to view the column values of a selected
table.

6. Click OKto return to the Extraction Configuration Wizard, Currently
Selected Source Tables wizard page, and Next to continue.

Select Source Columns

A wizard page appears showing the columns currently selected to be
exported from the source tables:
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Figure 5-7 Currently Selected Table Columns

To select additional data source columns:

1. Click the Columns button to open the table column dialog box where
you can add, or remove columns. All the columns of the previously
selected tables are available:
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Figure 5-8 Select Table Columns

2. Choose a table from the Source drop-down list. The columns of the
selected table are listed on the left-hand side of the screen. Select a
column from the sources list and click Add to move it into the selected
list or Remove to remove items from the selected column list.

3. Each column can have an alias. To add an alias for a column, select
the column and enter a name in the Alias field. The alias name you
create must be unique.

4. The Free Text button enables you to enter SQL code to adjust
column values. To use Free Text to enter SQL code:

a. Click New Field . This creates an entry in the Selected columns
field.

b. Select the new entry, and click the Free text button. The Free
text dialog box is displayed.

c. In the Free text dialog box, enter the required SQL code and field
names in the Enter free text for this column field.
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d. The Fields button enables you to choose fields from the selected
columns to be inserted at the position of the cursor in the Free text
field.

e. The Show Column Results button lists the resulting values
produced by the SQL statement in a pop-up dialog box.

f. Click OKto return to the Select table columns dialog box.

5. Use the Show Value button to view the real values of the selected
columns.

6. Use the Block this column check box to block the currently selected
column. You may want to do this, for example, when a column is in a
parent relation but you do not want to extract the data. When a
column is blocked, it will not be listed behind ATT=.

7. Click OKto return to the Extraction Configuration Wizard, Select
Source Columns wizard page.

8. Choose the Select distinct check box to ensure that duplicate columns
are not extracted.

9. Click Next to continue.

Enter the Parent Relation

One parent class can be entered for each class. To enter a parent for the
class:

1. Select the Yes option in answer to the question "Does this class have a
parent?". The default is No, if you do not want to create a parent
relation leave the setting as No and click Next :
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Figure 5-9 Enter Parent Relation

2. Select the class name of the parent in the field on the right from the
drop-down list of all previously entered class names.

3. The Relation name is optional.

4. Click Fields to open a list that includes all tables previously selected
for this class. The list will include all columns available for the
selected tables. Select one of the columns from the list.

5. Click the Attribute button to open a list of previously selected tables
for the parent class. The list will include alias names or columns
available for the selected tables. Select the appropriate column. This
information is entered after the ATT line of the parent in the
configurable ini file.

6. Click Next to Continue.

Join Tables

Tables can be joined to help link information in columns. For example,
you may want to link information from one column to a code table
definition listed in another column.

In this dialog box you can see all joined tables for this class:
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1. Click Joins to define the conditions for joining tables:

Figure 5-10 Joined Tables

2. To add a new joining condition, click the Fields button on the left
portion of the dialog box. A list of all selected tables and all columns
available for those tables will be visible:
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Figure 5-11 Add a Joining Condition

3. Select the table and column.

4. Click Fields on the right portion of the dialog box. A list of all
selected tables and all columns available for those tables will be
visible. Select the column you want to join with the one selected in
step 2.

5. Click Add to add the joining condition to the list.

NOTE The syntax used by the wizard for a join is a comma (,). When a join is
created by the above method this syntax is automatically used,
however if you are modifying an existing ini file any existing joins
that use LEFT JOIN, JOIN, or RIGHT JOIN will not be displayed in
the wizard. You must replace these joins manually using a text editor,
Chapter 578



Extraction Configuration Wizard
Classes
before they can be displayed.

6. The following options are only available for Oracle database users.
Select one of the following options:

• Left column always has a reference in right column, this refers to
an outer join.

• Left column does not always have a reference in right column, this
refers to a left outer join. The left column may be Null.

• Right column does not always have a reference in left column, this
refers to a right outer join. The right column may be Null.

7. Click OKto return to the Extraction Configuration Wizard, Join
Tables wizard page.

8. Click Next to continue.

Filter Data

Filters can be defined for each class being exported. Each filter can then
be blocked or activated from a subsequent Filter conditions dialog box.
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Figure 5-12 Filter Data

To create a new filter definition:

1. Click the Filter button to open the Filter conditions dialog box:
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Figure 5-13 Add a Filter Condition

2. Click Fields to select the table and column that you want to apply
the filter to.

3. In the Operator field, use the drop-down list to select an operator. The
Operators available vary depending on the field type, as different
operators are needed for text, numbers, or dates. The operator
selected may also affect what you do with the Value field. For
example, if the field type is numerical and the Between operator is
chosen, two value fields are displayed. First place the cursor in one
field, click Value and select a value from the list, place the cursor in
the other field and repeat the action. For a different field type the Is
In operator will show a list of check boxes you can select.

4. Click Value to select the value range.

5. Click Add when you are finished with the definition. You can add
multiple filter definitions for each table column selected.

6. Click OKto return to the Extraction Configuration Wizard, Filter
Data wizard page.

7. Click Next to continue.
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Data Sort Order

Use this wizard page to select the order in which data is exported. This
can be an important step if the data being exported needs to be imported
in a specific order. This screen initially shows sort order currently
defined in the database, to change it:

Figure 5-14 Current Sort Order

1. Click Sort by to open another dialog box where you can establish the
sort order:
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Figure 5-15 Sorting Data

2. Click Fields to view a list of all tables and columns previously
selected. You can enter a maximum of four table columns per class.

3. Click on the table column you want to sort by to enter it in the field.

4. Select the Ascending or Descending option for each table column
entered.

5. Click OKto return to the Extraction Configuration Wizard, Current
Sort Order wizard page.

6. Click Next to continue.

Enter Settings for Loading Classes

Use this option to achieve a faster extraction rate.

• If you select the Yes option, tables will only be loaded in the system
memory and not in the database when exported. This will speed up
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the processing time. You can select this option for each class.

Figure 5-16 Enter Settings for Loading Classes

• To set a maximum number of records fetched, select the Yes option in
the lower half of the dialog box and then type in the number of
records. This will limit the number of records extracted from the
database to the number entered.

• Click Next to continue.

Name and Block a Class

Use this wizard page to give a name to the settings you have just defined.
This name will be displayed in the classes of the wizards main screen.

1. Enter a Name for this class, do not use spaces in the name. This name
will appear as the class name in the exported XML file. If you
configure the import mapping in Data Exchange you will map this
name from the XML file to the correct item in Service Desk:
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Figure 5-17 Name and Block a Class

2. Select the Blocked check box if you do not want to export the class.
You can change this option for each class as often as necessary.

3. Click Finish to save all of your settings to a temporary table and
return to the Classes tab page.

NOTE The setting defined above will not be saved to the ini file until you click
Save ini file on the main Extraction Configuration Wizard page, see
“Introduction” on page 64.
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During the process of configuring an ini file the following error messages
may be generated. These problems are most likely to occur when you are
modifying a previously configured file.

NOTE The use of upper case and lower case must be consistent within an ini file
(for example a table can't be named Sites_DATA in one place and
Sites_Data in another). Although this does not produce an error message
itself it may be the cause of other messages.

Possible Errors While Reading the ini File

Cannot find parent '<parent_name> '.
The class that is mentioned as parent does not exists.

Cannot read from file '<file_name> '.
The file is not readable.

Class '<class_name> ' cannot have itself as parent.
A class cannot have itself as parent defined.

Connection to <dsn_name> as <user_name>/<password> failed.
Connection to the external source using the settings in the DSN section
failed.

Misplaced brackets in line '<line> '
The order or number of brackets [ ] in the line is not correct.

No '=' in parent relation.
No equal sign can be found in the parent relation.

No operator found in condition '<condition> '.
The condition does not have an operator.

No references to tables found in condition '<condition> '.
There must be 1 (filter) or 2 (join) references to tables or columns in the
condition. The table name and column name, or column name only,
defined in a filter or join must be found in the database.

No table and column found in ordering '<ordering> '.
The ordering should refer to a table and column. The table name and
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column name, or column name only, defined in a filter or join must be
found in the database.

Parsing stopped.
Parsing has been stopped due to previous errors.

Unknown columnname '<column_name> ' in parent relation.
The parent's column mentioned in the parent relation is unknown.

Unknown tablename '<table_name> ' in parent relation.
The source table mentioned in the parent relation is unknown.

Wrong number of values in condition '<condition> '.
The number of values does not match the operator in the condition.

Possible Errors While Writing the ini File

Cannot write to file '<file_name> '.
The file is not writable.
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6 Approval

This chapter describes the Approval feature in HP OpenView Service
Desk. The information provided in this chapter will optimize the
approval process within your IT services.
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The topics covered include:

• Introduction to Approval

• Enabling Approval Sheets

• Creating Approval Sheets

• Activating Approval Sheets

• Monitoring Approval Sheets

• Voting on Approval Sheets
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The delivery of business-critical IT services depends on prompt decision
making. Steps within the IT management process may need to be
authorized to provide agreed-upon service levels. Ensuring that the
appropriate specialists are involved in decision making before
implementation is crucial to productivity. When authorizing IT
management processes, it is counter-productive and time-consuming to
manually track issues requiring action.

Service Desk Approval provides a structured, process-oriented
mechanism that supplies an effective method of managing and
authorizing IT management processes.

The following processes are supported by Approval:

• Help Desk Management

• Incident Management

• Problem Management

• Change Management

• Configuration Management

• Project Management

Overview of Approval

Approval provides the ability to automatically request authorization for
issues requiring action. For example, a change to your network is
required. How can the appropriate specialists authorize this change in a
timely manner? Approval ensures that agreements to proposed actions
are secured automatically in line with your company’s strategy.

When an action requires an approval, an approval sheet must be
completed. The status of the approval sheet is initially Inactive. In this
stage, the approval sheet indicates a deadline date for a response and the
specialists who should authorize the action.

The status of the approval sheet should be changed from Inactive to
Active to begin the approval process.

An active approval sheet automatically notifies the approvers within
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Service Desk in the Service Today view. The approvers then vote by
selecting Yes or No. The results are automatically tabulated and, when
enough predetermined approvers have authorized the action, the
approval status automatically changes to ready. The approval result
reflects that the approval task has been completed and, if approved,
implementation can begin.

If approvers have not entered a vote at the end of the predetermined
approval period, the approval sheet status automatically changes to
Ready. The approval result, however, is Rejected.

Figure 6-1 Approval Process

Approval Sheets

Approval Sheets can be added to any form within Service Desk. When
opening a form, a tab for the Approval Sheet is enabled. The initiator of
the approval process as well as the designated approvers will be able to
view the approval sheet.

The approval sheet serves dual purposes: as a ballot for the designated
approvers as well as a means to start the approval process.
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Figure 6-2 Approval Sheet

The Approval Sheet consists of the following fields:

• Approval Status

The approval status can be set to Inactive, Active or Ready.

• Deadline

This is the last date that a vote on an approval sheet can be received.

• #Approvers Req

The number of accepted votes required by the designated specialists
before the process is approved.

• Strategy

The strategy describes how many approvals are required out of the
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total pool of specialists that were asked to vote. For example, if 10
specialists were asked to approve an action, if your company strategy
is that only one of the specialists must approve the process, then the
strategy would be 1 out of 10.

• Approval

This field reflects the approval group that would authorize an action.
This group can be an organization or several specialists within the
same department.

• Approval Votes

Information regarding the specialists voting on actions can be
previewed here. The preview contains the approver’s name and vote.
If the specialist has rejected the action, a reason will be displayed.

• Result

This field reflects the results of the voting.

Approval Roles

The responsibilities of your specialists are based on their areas of
expertise. To best utilize their knowledge, as well as strengthen your
help desk performance, several crucial roles must be identified. The
approval roles will assist in developing effective implementation of
Service Desk Approval.

To implement the Approval feature, you should identify staff for the
following roles within your organization:

1. Approval initiator

An action requiring approval must be identified. This process is
completed by specialists, help desk employees, change managers,
problem managers, or anyone authorized within your organization.

2. Approval activator

Changing the status of an approval sheet from Inactive to Active is
crucial to beginning the approval process. An approval activator can
be the approval initiator or someone designated by your organization
to review proposed approvals before beginning the approval process.

3. Approver

The specialist who is designated by the approval activator or approval
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initiator need to vote on the approval sheets. The specialists are
notified automatically of issues requiring their vote. Approvers can be
individual specialists or part of a defined group.

4. Approval monitor

To ensure that decisions are made in a timely manner, a role such as
a change manager may be designated to monitor approval sheet
statuses. If an approval sheet has not been voted upon before the
deadline, the approval watcher can be designated for final
authorization.
Chapter 6 95



Approval
Approval Status
Approval Status

Inactive

When the status is set to Inactive, the approval group or approver(s) can
be designated on an action. The approvers, however, are not notified
until the status is set to Active.

Active

The approval process begins if the status is set to Active. Setting an
approval status to Active can be completed manually.

Ready

When an Approval Sheet has been approved or rejected, the status
changes to Ready. The requested action is authorized for
implementation.
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Approval Result

Approved

If the required number of approvals are received, the result will indicate
Approved.

Rejected

If the required number of approvals are not received by the deadline date
or the approvers have rejected a request, the result will indicate
Rejected.

Incomplete

If further information is required before the approval process can begin,
the result is incomplete.
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Enabling the Approval Sheet
To effectively use the Approval feature, you must have a clear
understanding of forms usage in Service Desk. In addition, you need
system administrator rights. For additional information, refer to Service
Desk Online Help, Forms.

An Approval Sheet can be added to the following forms within Service
Desk:

• Change

• Project

• Work order

• Service call

• Incident

• Problem

Adding Approval Sheets to Forms

Form settings must include an Approval tab page to implement the
Approval feature. For example, you may wish to add an Approval Sheet
tab page to the Problem or Incident forms. Follow the steps below to set
up or modify forms which do not have Approval Sheets as a standard
feature:

1. From the Tools menu, click System , then double-click the
Presentation icon in the Administrator Console.

2. Click the Forms icon in the Navigation pane.

3. Select the form you want to add an Approval Sheet to, for example
Problem.

4. Choose New Page from the Page menu.

5. Type Approval Sheet in the Namefield.

6. Click OK.

7. Select Approval from the Attribute list.

8. Drag and drop the Approval element from the Attributes list onto
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the Approval Sheet.

9. Drag and drop the Initiator element, if required, from the
Attributes list onto the Approval Sheet.

To begin an Approval process, an initiator’s name must be indicated.

10.Choose Save from the File menu.

11.Close the Administrator console .

Figure 6-3 Adding an Approval Sheet to a Form
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Creating Approval Sheets
The first step in the Approval process is the completion of an approval
sheet.

To create a task for Approval within a form:

1. Click the Approval Sheet tab.

2. Enter the initiator’s name in the Initiator field.

3. Click the Deadline field and enter a date.

The deadline date is crucial in the Approval process. If the approvers
have not voted on the Approval Sheet by this date, the request will
automatically time out. The Approval Sheet will then be rejected.

4. Enter the name of an approval group in the Approval field. The
names of each member of the group or the name of the organization
will appear in Approval Votes.
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Figure 6-4 Entering an Approval Group

5. In the #Approvers Req field, click the arrow to indicate how many
approvals are required. By clicking the up arrow, you will increase the
number of required approvals. By clicking the down arrow, you will
decrease the number of required approvals.

6. Click Save and Close .

NOTE The approval status must be set to Active to be enabled.
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NOTE The initiator of the approval request as specified in the Initiator field
is the only person authorized to complete the deadline and list of
approvers.

Adding Approvers Outside of an Approval Group

If the specialists you wish to vote on an approval sheet are not members
of a group, use the following method:

Approvers can be designated from approval groups or individually.

To add approvers:

1. Select the Approval Sheet.

2. Click the Deadline field and enter a date.

3. In Approval Votes , right-click your mouse button and select New
Approval Vote .

4. Enter the approver’s name.
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Figure 6-5 Adding an Approver

5. Click OK.

6. In the #Approvers Req field, click the arrow to indicate how many
approvals are required, if necessary. By clicking the up arrow, you will
increase the number of approvals required by one.
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Modifying Approvers

To modify approvers:

1. Highlight the Approver in Approval Votes .

2. Click Modify within the Approval Sheet, or double-click the
approver’s name.

3. Make the required changes within Approver .

4. Click OK.

NOTE Once the approval status has been changed from Inactive to Active ,
you will be unable to modify approvers. Modify is replaced by View when
the approval status is Active.

Removing Approvers

To remove approvers from the approval sheet:

1. Select the approver’s name.

2. Click Remove.

3. Click Yes in the pop-up dialog box.
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Activating Approval Sheets
The approval status is set to Inactive and must be manually changed to
Active. When the approval status is Active, the approval process begins.

To change the status of an approval sheet:

1. Click the Approval Sheet tab.

2. In the Approval Status field, select Active .

3. Click Save and Close.

NOTE When the approval status is Active, approval voting is enabled.
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Figure 6-6 Approval Status Change
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Monitoring Approval Sheets
A role, such as a change manager, should monitor approval sheets to
ensure timely implementation. Approval Sheets, however, can be
monitored by anyone within your help desk requiring status information.

To check the status of an approval:

1. Open the Approval Sheet .

2. Look at the Result field. This field will indicate the current status of
of the approval voting process on the Approval Sheet.

3. Highlight Approver in Approval Votes.

4. Click the Preview button.

Information is displayed on the approver, the approval vote and reason
in the Preview pane. To view more specific information, click the View
button.
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Figure 6-7 Approval Vote Preview
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Figure 6-8 Approval Vote View
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Voting on Approval Sheets
Once the Approval Sheet is active, specialists are able to access the
Approval Vote field of an action requiring their vote. When you click the
Modify button, the Approval Vote display box is enabled on the approval
sheet.

NOTE When the Approval Vote field is enabled on an action, note the deadline
date on the approval sheet. You must approve or reject the request by the
deadline date or you will lose your option to vote.

To vote on an Approval Sheet , within the Approval Vote box:

1. Click the arrow in the Approved field.

2. Select Yes or No. If you select No, type a response in the Reason field

Figure 6-9 Voting Yes on an Approval Sheet

Figure 6-10 Voting No on an Approval Sheet

3. Click OK.
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Approval Votes has now been updated to reflect your vote. If you have
voted Yes, when the required number of approvals have been received,
the Result field will indicate the Approval Sheet has been approved.

If you have voted No, The Result field may indicate that the Approval
Sheet has been rejected (depending on the defined strategy).

NOTE When rejecting an Approval, you must supply information in the Reason
field.
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